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Paper Set 1 · 04 Jun 2026 · 4:00 PM - 5:30 PM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
ଜଣେ ଦୋକାନୀ ତାଙ୍କ ଦ୍ର ବ୍ୟର ଧାର୍ଯ୍ୟ  ମୂ ଲ୍ୟକୁ  କ୍ର ୟ ମୂ ଲ୍ୟ ଅପେକ୍ଷା 25% ଅଧି କ ରଖନ୍ତି
ଏବଂ ସେହି  ଧାର୍ଯ୍ୟ  ମୂ ଲ୍ୟ ଉପରେ 10% ରି ହାତି  ପ୍ର ଦାନ କରନ୍ତି  । ତେବେ ତାଙ୍କର ଶତକଡ଼ା
ଲାଭ ବା କ୍ଷତି ର ପରି ମାଣ କେତେ?

A.  12.5 % ଲାଭ

B.  12.5 % କ୍ଷତି

C.  12.7 % ଲାଭ

D.  10.5 % ଲାଭ

✓

Q2 Quant
Pooja and Meena can complete a task in 10 days, while Raj and Anil
can complete the same task in 15 days. How long will Pooja, Meena,
Raj, and Anil take to complete it together?

A.  6 days

B.  5 days

C.  8 days

D.  4 days

✓

Q3 Quant
A and B start a business. A invests ₹1,20,000 and B invests
₹1,60,000. After a few months, C joins with ₹1,80,000. At the end of
the year, the profit is divided in the ratio 3 : 4 : 3. After how many
months did C join?

A.  4

B.  6

C.  3

D.  5

✓

Q4 Quant
The highest common factor (HCF) of the two numbers 72 and 126 is:

A.  9

B.  12

C.  16

D.  18

✓

Q5 Quant
ରାସ୍ତା କଡ଼ରେ ଥି ବା ଟେଲି ଗ୍ରା ଫ ଖୁ ଣ୍ଟଗୁ ଡ଼ି କ ମଧ୍ୟରେ ଦୂ ରତା 50 ମି ଟର ଅଟେ । ଯଦି  ପ୍ର ଥମ
ଖୁ ଣ୍ଟ ଅତି କ୍ର ମ କରି ବାର ଠି କ ପୂ ର୍ବ ରୁ  ଗଣନା ଆରମ୍ଭ ହୁ ଏ, ତେବେ କାରର ବେଗ 45 km/hr
ହେଲେ 4 ଘଣ୍ଟାରେ କାରଟି  ସେଗୁ ଡି କ ମଧ୍ୟରୁ  କେତୋଟି କୁ  ଅତି କ୍ର ମ କରି ବ?

A.  3601

B.  3600

C.  3602

D.  3605

✓

Q6 Quant
ଷ୍ଟି ଭ୍  40 km/hr ବେଗରେ ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ ଦୂ ରତା ଅତି କ୍ର ମ କରନ୍ତି  । ଯଦି  ସେ ବେଗକୁ  48
km/hr କୁ  ବୃ ଦ୍ଧି  କରନ୍ତି , ତେବେ ସେ ସେହି  ଦୂ ରତା ଅତି କ୍ର ମ କରି ବା ପାଇଁ  45 ମି ନି ଟ କମ
ସମୟ ନି ଅନ୍ତି  । ଷ୍ଟି ଭ୍  କେତେ ଦୂ ରତା (km ରେ)ଯାତ୍ରା  କରନ୍ତି  ?

A.  150

B.  168

C.  174

D.  180

✓

Q7 Quant
Four friends P, Q, R, and S start a business together. P invests
₹15,000 for 12 months, Q invests ₹20,000 for 9 months, R invests
₹25,000 for 8 months, and S invests ₹30,000 for 6 months. If the
total profit is ₹56,000, what is Q's share (Rounded off to the nearest
integer).

A.  ₹13,682

B.  ₹13,652

C.  ₹13,622

D.  ₹13,602

✓

Q8 Quant
ଯଦି  28, X ଓ 42 ର ଚତୁ ର୍ଥ  ସମାନୁ ପାତୀ 105 ହୁ ଏ, ତେବେ X ର ମୂ ଲ୍ୟ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  42

B.  56

C.  70

D.  84
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✓

Q9 Quant
In a moderately skewed distribution, if the mode is 12 less than the
median and the mean is 42, find the median.

A.  32

B.  36

C.  37

D.  39

✓

Q10 Quant
ଯଦି  ଗୋଟି ଏ ସଂଖ୍ୟାର 20% କୁ  42 ସହି ତ ଯୋଗ କରାଯାଏ, ତେବେ ଫଳାଫଳ ସମାନ
ସଂଖ୍ୟା ହେବ । ସମାନ ସଂଖ୍ୟାର 70% _________ ଅଟେ ।

A.  36.75

B.  46.75

C.  66.75

D.  56.75

✓

Q11 Quant
A, B and C can together finish a piece of work in 2 days. If A alone
can finish the same work in 16 days and B can also do it alone in 16
days, how many days will C take to finish thrice the same work
alone?

A.  8

B.  16

C.  24

D.  9

✓

Q12 Quant
ଏକ ଭାଗକ୍ରି  ୟାରେ ଭାଜକ ଭାଗଫଳର 8 ଗୁ ଣ ଏବଂ ଭାଗଶେଷ 5 ଗୁ ଣ ଅଟେ । ଯଦି
ଭାଗଶେଷ 48 ହୁ ଏ, ତେବେ ଭାଜ୍ୟ କେତେ ଅଟେ?

A.  7248

B.  7253

C.  7243

D.  7252

✓

Q13 Quant
ବାର୍ଷିକ 4% ସରଳ ସୁ ଧ ହାରରେ 5 ବର୍ଷ ରେ କେତେ ମୂ ଳଧନ (₹ ରେ)ର ସମୂ ଳସୁ ଧ
₹4920 ହେବ?

A.  4100

B.  4050

C.  4150

D.  24600

✓

Q14 Quant
ଯଦି  ବାର୍ଷିକ ଭାବେ ଚକ୍ର ବୃ ଦ୍ଧି  ହେଉଥି ବା ବାର୍ଷିକ 4% ଚକ୍ର ବୃ ଦ୍ଧି  ସୁ ଧ ହାରରେ ₹y
ମୂ ଳଧନ ଉପରେ 2 ବର୍ଷ ର ଚକ୍ର ବୃ ଦ୍ଧି  ସୁ ଧ ₹255 ହୁ ଏ, ତେବେ 2 ବର୍ଷ  ପରେ ସମୂ ଳସୁ ଧ
କେତେ ହେବ?

A.  ₹3380

B.  ₹3170

C.  ₹2961

D.  ₹3727

✓

Q15 Quant
The bisectors of ∠B and ∠C of an isosceles ∆ABC with AB = AC,
intersect each other at O. If ∠BOC = 110°, find the measure of
external angle ∠ABD, where D lies on the extended part of side CB.

A.  70°

B.  80°

C.  110°

D.  100°

✓

Q16 Quant
ଦୁ ଇଟି  ପରି ପୂ ରକ କୋଣ ମଧ୍ୟରୁ  ବୃ ହତ୍ତର କୋଣଟି ର ପରି ମାଣ କ୍ଷୁ ଦ୍ର ତର କୋଣଟି ର
ପରି ମାଣ ଅପେକ୍ଷା 46° ଅଧି କ । ତେବେ କ୍ଷୁ ଦ୍ର ତର କୋଣଟି ର ପରି ମାଣ
__________(ଡି ଗ୍ରୀ ରେ) ଅଟେ ।

A.  67

B.  61

C.  60

D.  63

✓

Q17 Quant
A number when increased by 60%, gives 3920. The number is:

A.  2450

B.  2900

C.  1225

D.  1350

✓

Q18 Quant
Rina sells a toy to Reshmi at a profit of 20%. Reshmi sells the same
toy to Chandra for ₹2160 and makes a profit of 20%. What is the cost
price at which Rina purchased the toy?

A.  ₹1300

B.  ₹1400

C.  ₹1500

D.  ₹1600

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q19 Quant

A.  

B.  

C.  

D.  

✓

Q20 Quant

1552

A.  75°

B.  90°

C.  110°

D.  125°

GA

✓

Q21 GA
In May 2025, Prime Minister Narendra Modi inaugurated the
Vizhinjam International Seaport in which of the following states?

A.  Andhra Pradesh

B.  Karnataka

C.  Kerala

D.  Tamil Nadu

✓

Q22 GA
ନି ମ୍ନ ଲି ଖି ତ ରାଜ୍ୟମାନଙ୍କ ମଧ୍ୟରୁ  କେଉଁ  ରାଜ୍ୟ 2025 ମସି ହା ମଇ ମାସରେ ଭାରତର ପ୍ର ଥମ
ଭି ଷ୍ଟାଡୋମ ଟ୍ରେ ନ (Vistadome train) ଜଙ୍ଗଲ ସଫାରୀ ଆରମ୍ଭ କରି ଛି ?

A.  ଉତ୍ତରପ୍ର ଦେଶ

B.  ଝାଡଖଣ୍ଡ

C.  ମଧ୍ୟପ୍ର ଦେଶ

D.  କର୍ଣ୍ଣା ଟକ

✓

Q23 GA
The atomic mass of oxygen is approximately:

A.  15.999 u

B.  8 u

C.  16.999 u

D.  12.000 u

✓

Q24 GA
ଭୁ ବନେଶ୍ୱର ନି କଟସ୍ଥ ଉଦୟଗି ରି ରେ ଖୋଦି ତ ହୋଇଥି ବା ହାତୀଗୁ ମ୍ଫା ଶି ଳାଲେଖ କେଉଁ
ରାଜାଙ୍କର କୀର୍ତ୍ତିବର୍ଣ୍ଣ ନା କରେ?

A.  ଅଶୋକ

B.  ଖାରବେଳ

C.  ସମୁ ଦ୍ର ଗୁ ପ୍ତ

D.  ଅନନ୍ତବର୍ମ ନ ଚୋଡଗଙ୍ଗ
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✓

Q25 GA
ଗୋଟି ଏ କୋଷ ବି ଭାଜି ତ ହେବାକୁ  ଯାଉଥି ବା ସମୟରେ, କ୍ରୋ ମାଟି ନ ପଦାର୍ଥ ର କ’ଣ
ହୋଇଥାଏ?

A.  କୋଷରୁ  ଅଦୃ ଶ୍ୟ ହୋଇଯାଏ

B.  କ୍ରୋ ମୋଜୋମରେ ସଂଗଠି ତ ହୁ ଏ

C.  RNA ରେ ପରି ବର୍ତ୍ତ ନ ହୁ ଏ

D.  ନ୍ୟଷ୍ଟି ରୁ  ବାହାରକୁ  ଗତି  କରେ 

✓

Q26 GA
ଅଗଷ୍ଟ 2025 ରେ CCEA ଏକ 6-ଲେନ ବି ଶି ଷ୍ଟ ପ୍ର ବେଶ-ନି ୟନ୍ତ୍ରି ତ (access-controlled)
କ୍ୟାପି ଟାଲ ରି ଜି ଅନ ରି ଙ୍ଗ ରୋଡ (ଭୁ ବନେଶ୍ୱର ବାଇପାସ) ନି ର୍ମା ଣକୁ  ମଞ୍ଜୁ ରୀ ପ୍ର ଦାନ
କରି ଥି ଲେ । ଏହାର ଅନୁ ମୋଦି ତ ଦୈ ର୍ଘ୍ୟ  କେତେ?

A.  98.400 km

B.  110.875 km

C.  125.000 km

D.  150.250 km

✓

Q27 GA
ସୁ ପ୍ତ ଆଗ୍ନେୟଗି ରି କୁ  ସାଧାରଣତଃ ________ କୁ ହାଯାଏ ।

A.  ସ୍ଳି  ପି ଙ୍ଗ ଆଗ୍ନେୟଗି ରି  (Sleeping volcanoes)

B.  କମ୍ପୋଜି ଟ୍  ଆଗ୍ନେୟଗି ରି  (Composite volcanoes)

C.  ଇରପଟି ଙ୍ଗ ଆଗ୍ନେୟଗି ରି  (Erupting volcanoes)

D.  ଡେଡ ଆଗ୍ନେୟଗି ରି  (Dead volcanoes)

✓

Q28 GA
କେଉଁ  ଭାରତୀୟ ସ୍ଥାନକୁ  UNESCO ଦ୍ୱାରା ଏହାର ଜୁ ଆରି ଆ ପରି ସଂସ୍ଥା ନି ମନ୍ତେ ଏକ ବି ଶ୍ୱ
ଐତି ହ୍ୟ ସ୍ଥଳୀ ଭାବରେ ସ୍ୱୀକୃ ତି  ପ୍ର ଦାନ କରାଯାଇଛି ?

A.  ନାଗରହୋଲ 

B.  ଗି ର

C.  ସୁ ନ୍ଦରବନ

D.  ପେରି ଆର

✓

Q29 GA
ସେପ୍ଟେମ୍ବର 2025 ରେ ସମ୍ବଲପୁ ରରେ ଅନୁ ଷ୍ଠି ତ ରାଜ୍ୟସ୍ତରୀୟ ନୂ ଆଖାଇ ଭେଟଘାଟ
ସମୟରେ, ଓଡ଼ି ଶା ମୁ ଖ୍ୟମନ୍ତ୍ରୀ ସମ୍ବଲପୁ ର ଦେଇ _________ ରୁ  __________ ପର୍ଯ୍ୟ ନ୍ତ ଏକ
ଶି ଳ୍ପ କରି ଡର ବି କାଶ ଘୋଷଣା କରି ଥି ଲେ ।

A.  ପାରାଦ୍ଵି ପ; ରାଉରକେଲା

B.  ଭୁ ବନେଶ୍ୱର; କଟକ

C.  ପୁ ରୀ; ଭୁ ବନେଶ୍ୱର

D.  ଜୟପୁ ର; କୋରାପୁ ଟ 

✓

Q30 GA
ଓଡ଼ି ଶାର ଉପକୂ ଳ ସମତଳ କ୍ଷେତ୍ର  __________ ନାମରେ ମଧ୍ୟ ଜଣାଶୁ ଣା ଅଟେ ।

A.  ପାଞ୍ଚଟି  ନଦୀର ଉପହାର

B.  ଛଅଟି  ନଦୀର ଉପହାର

C.  ସାତଟି  ନଦୀର ଉପହାର

D.  ଆଠଟି  ନଦୀର ଉପହାର

✓

Q31 GA
Who among the following assumed charge as the Director General
of the National Cadet Corps (NCC) in 2025?

A.  Lt Gen Gurbirpal Singh

B.  Lt Gen Rajesh Sharma

C.  Lt Gen Virendra Vats

D.  Lt Gen Manoj Pande

✓

Q32 GA
ଭାରତୀୟ ଜାତୀୟ ଆନ୍ଦୋଳନରେ ଦାଦାଭାଇ ନାରୋଜୀଙ୍କ "ଡ୍ରେ ନ୍  ଥି ଓରୀ" (Drain
Theory) ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଥି ଲା, କାରଣ ଏହା _______ ।

A.  ବ୍ରି  ଟି ଶ ଅର୍ଥ ନୈ ତି କ ନୀତି କୁ  ଭାରତର ବି କାଶ ପାଇଁ  ଲାଭଦାୟକ ବୋଲି  ଯଥାର୍ଥ
କରି ଥି ଲା

B.  ଭାରତରେ ଉତ୍ପାଦି ତ ସମ୍ପତ୍ତି  କି ପରି  ବି ନା ପର୍ଯ୍ୟା ପ୍ତ ପ୍ର ତି ଦାନରେ ବ୍ରି  ଟେନକୁ
ସ୍ଥାନାନ୍ତରି ତ ହୋଇଥି ଲା

C.  ଭାରତରେ ଦାରି ଦ୍ର୍ୟ ର ମୁ ଖ୍ୟ କାରଣ ଭାବରେ କେବଳ କୃ ଷି  କର ବ୍ୟବସ୍ଥା ଉପରେ
ଧ୍ୟାନ କେନ୍ଦ୍ରି ତ କରି ଥି ଲା

D.  ବ୍ରି  ଟି ଶ ଶାସନ ଅଧୀନରେ ଭାରତରେ ଶି ଳ୍ପାୟନର ପ୍ର କ୍ରି  ୟା ଅଧି କ ଦ୍ରୁ ତ ଥି ଲା ବୋଲି
ଯୁ କ୍ତି  କରି ଥି ଲା

✓

Q33 GA
ଗୋଟି ଏ ସଳଖ ବି ଦ୍ୟୁ ତ ପରି ବାହୀରେ (Straight current-carrying conductor)
ଯଦି  ବି ଦ୍ୟୁ ତ ସ୍ରୋ ତ ବୃ ଦ୍ଧି  କରାଯାଏ, ତେବ ଚୁ ମ୍ବକୀୟ କ୍ଷେତ୍ର ର ପରି ମାଣ କି ପରି  ପରି ବର୍ତ୍ତିତ
ହୁ ଏ?

A.  ହ୍ରା ସ

B.  ବୃ ଦ୍ଧି

C.  କୌଣସି  ପରି ବର୍ତ୍ତ ନ ନାହିଁ

D.  ଓଲଟା

✓

Q34 GA
2026 ଫେବୃ ଆରୀ ମାସରେ ଭାରତ ନୂ ଆଦି ଲ୍ଲୀରେ "ଏ.ଆଇ. ଇମ୍ପାକ୍ଟ ସମ୍ମି ଳନୀ" (AI
Impact Summit) ଆୟୋଜନ କରି ଥି ଲା । ସମ୍ମି ଳନୀର ଘୋଷଣାନାମା ସାତୋଟି  ମୁ ଖ୍ୟ
ସ୍ତମ୍ଭ ଉପରେ କେନ୍ଦ୍ରି ତ ଥି ଲା, ତାହା ନି ମ୍ନ ଲି ଖି ତ କ'ଣ ଭାବେ ଜଣାଯାଏ?

A.  ସାତ ଚକ୍ର

B.  ସାତ ଜ୍ଞାନ

C.  ସାତଟି  ଡି ଜି ଟାଲ କୋଡ

D.  ସାତ ପ୍ରା ଚୀର
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✓

Q35 GA
ଅମୀର ଖୁ ସ୍ରୋ ଙ୍କ ସମ୍ପର୍କ ରେ ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ବି ବୃ ତି ଟି  ସଠି କ ଅଟେ?

A.  ସେ ଗ୍ୱା ଲି ୟରରେ ଜନ୍ମ ଗ୍ର ହଣ କରି ଥି ଲେ ଏବଂ ସମ୍ରା ଟ ଆକବରଙ୍କ ଦରବାରରେ
ଜଣେ ବି ଶି ଷ୍ଟ ସଙ୍ଗୀତଜ୍ଞ ଭାବରେ କାର୍ଯ୍ୟ  କରି ଥି ଲେ ।

B.  ତାଙ୍କୁ  ଧ୍ରୁ ପଦ ସଂଗୀତ ଶୈ ଳୀର ପ୍ର ମୁ ଖ ସ୍ର ଷ୍ଟା ଭାବରେ ବି ବେଚନା କରାଯାଏ ।

C.  ସୀତାର ଏବଂ କୱାଲୀ ତଥା ତରାନାର ସଙ୍ଗୀତମୟ ଧ୍ୱନି ର ସୃ ଷ୍ଟି  ପାଇଁ  ଶ୍ରେ ୟ ଲାଭ
କରି ଛନ୍ତି  ।

D.  ସେ ମି ଆଁ  ତାନସେନଙ୍କ ଜଣେ ଶି ଷ୍ୟ ଥି ଲେ ଏବଂ ତାଙ୍କ ଠାରୁ  ଆରବୀୟ ଓ ପାରସି କ
ସଙ୍ଗୀତକଳା ଶି କ୍ଷା କରି ଥି ଲେ ।

✓

Q36 GA
Which countries lie to the north-west of India?

A.  China and Nepal

B.  Afghanistan and Pakistan

C.  Bhutan and Bangladesh

D.  Myanmar and Sri Lanka

✓

Q37 GA
ପ୍ର ଜନନ ବୟସ ମଧ୍ୟରେ ଜଣେ ମହି ଳାଙ୍କର ହାରାହାରି  କେତୋଟି  ସନ୍ତାନ ହେବ ବୋଲି  ଆଶା
କରାଯାଏ, ତାହା କେଉଁ  ସୂ ଚକାଙ୍କ ଦ୍ୱାରା ପ୍ର କାଶି ତ ହୋଇଥାଏ?

A.  ସାକ୍ଷରତା ହାର

B.  ଆୟୁ  ପ୍ର ତ୍ୟାଶା

C.  ମୋଟ ପ୍ର ଜନନ ହାର 

D.  ଲି ଙ୍ଗ ଅନୁ ପାତ

✓

Q38 GA
ଭରତ ମୁ ନି ଙ୍କ ନାଟ୍ୟଶାସ୍ତ୍ର ଅନୁ ଯାୟୀ, ଭାରତୀୟ ବାଦ୍ୟଯନ୍ତ୍ରଗୁ ଡ଼ି କର କେଉଁ  ଶ୍ରେ ଣୀ ଧ୍ୱନି
ଉତ୍ପାଦନ ପାଇଁ  ତାର ବ୍ୟବହାର ହେଉଥି ବା ବ୍ୟାଖ୍ୟା କରାଯାଇଛି ?

A.  ଘନ ବାଦ୍ୟ

B.  ସୁ ଶି ର ବାଦ୍ୟ

C.  ଅବନଦ୍ଧ ବାଦ୍ୟ 

D.  ତତ୍  ବାଦ୍ୟ 

✓

Q39 GA
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଭାରତର ଆଞ୍ଚଳି କ ଅର୍ଥ ନୈ ତି କ ଅସମାନତା (regional
economic disparity) ର ଏକ ମୁ ଖ୍ୟ କାରଣ ଅଟେ?

A.  ସମସ୍ତ ରାଜ୍ୟରେ ସମାନ ଶି ଳ୍ପ ବି କାଶ

B.  ଶି କ୍ଷା ଏବଂ ଭି ତ୍ତି ଭୂ ମି ରେ ସମାନ ଉପଲବ୍ଧତା 

C.  ସମ୍ବଳ ଏବଂ ନି ବେଶର ଅସମାନ ବଣ୍ଟନ 

D.  ସମସ୍ତ ଅଞ୍ଚଳରେ ସମାନ ଭାବରେ ଉଚ୍ଚ ଜନସଂଖ୍ୟା ଅଭି ବୃ ଦ୍ଧି

✓

Q40 GA
ଭାରତୀୟ ସମ୍ବି ଧାନର କେଉଁ  ଧାରା ରାଜ୍ୟକୁ  ପୁ ଷ୍ଟି ହୀନତା ରୋକି ବା ଏବଂ ଜନସ୍ୱାସ୍ଥ୍ୟର ଉନ୍ନତି
ପାଇଁ  ଆଇନ ପ୍ର ଣୟନ କରି ବା ନି ମନ୍ତେ ନି ର୍ଦ୍ଦେ ଶ ପ୍ର ଦାନ କରେ?

A.  ଧାରା 45

B.  ଧାରା 46

C.  ଧାରା 47

D.  ଧାରା 48

English

✓

Q41 English
Select the most appropriate option to fill in the blank.

Although the council _____ a vote, the outcome remained unofficial due to procedural delays.

A.  was conducted

B.  conducting

C.  had conducted

D.  conduct

✓

Q42 English
Select the option that can be used as a one-word substitute for the given group of words.

A place where dead bodies are kept before burial

A.  Graveyard

B.  Mausoleum

C.  Morgue

D.  Cemetery
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✓

Q43 English

Read the given passage carefully and answer the following questions.

Reality television is a type of show that claims to present unscripted dramatic or funny situations, real events, and ordinary people instead of
professional actors. Although such shows have been around for many years, they have become much more popular in recent times. One reason
people enjoy them is that they put regular individuals in unusual, challenging, or surprising situations, which attracts viewers’ attention. These
programs can also make participants widely known, sometimes turning them into celebrities or public figures. However, some experts say that
the term “reality television” is not entirely accurate because many shows are partially scripted and manipulated by producers. In competition-
based or special-living-environment shows, producers often dictate the format, guide daily activities, and curate the environment, creating a
partly artificial world for entertainment. Despite this, viewers still enjoy the mix of drama, excitement, tension, and human reactions these shows
consistently offer.

Identify the correct tone of the passage from the options.

A.  Highly critical and accusatory

B.  Enthusiastic and promotional

C.  Informative and balanced

D.  Sarcastic and dismissive

✓

Q44 English
Choose the option that suggests the main theme of the passage.

A.  How reality shows entertain viewers

B.  The role of celebrities in television

C.  How reality television works and its impact

D.  Differences between scripted and live shows

✓

Q45 English
Which statement is a fact according to the passage?

A.  Reality television has become more popular in recent times.

B.  Reality shows always reflect real life perfectly.

C.  Every participant becomes a public figure.

D.  The audience prefers scripted shows.

✓

Q46 English
Which of the following can be inferred from the passage?

A.  Reality shows are completely natural and unscripted.

B.  Producers often manipulate situations to increase drama.

C.  All participants become national celebrities.

D.  Reality television is declining in popularity.
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✓

Q47 English
It can be inferred from the passage that the appeal of reality shows comes from:

A.  offering only prizes to participants

B.  having complete lack of producer control

C.  the long duration of each episode

D.  showing ordinary people in unusual situations

✓

Q48 English
Identify the sentence that is not correctly written in indirect speech.

A.  Meera said that she had seen a koala in the park.

B.  Kiran asked if they were ready for the journey.

C.  They mentioned that the waves were calm.

D.  Priya said that I am love kangaroos.

✓

Q49 English
Select the most appropriate antonym of the underlined word in the given sentence.
The sky was opaque with thick clouds, blocking all sunlight.

A.  Dark

B.  Murky

C.  Transparent

D.  Cloudy

✓

Q50 English
Select the most appropriate proverb to substitute the highlighted segment in the given sentence.

He felt disappointed when the product looked impressive online but was poor in quality, proving that appearances can be misleading.

A.  when in Rome, do as the Romans do

B.  actions speak louder than words

C.  all that glitters is not gold

D.  beggars can’t be choosers

✓

Q51 English
Choose the option which has correct spelling of the underlined word in the given sentence.

She couldn’t hide her embarassment after tripping on the stage.

A.  She couldn’t hide her embarrassment after tripping on the stage.

B.  She couldn’t hide her embarasment after tripping on the stage.

C.  She couldn’t hide her after tripping on embarasement the stage.

D.  She couldn’t hide her embarrasmant after tripping on the stage.
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✓

Q52 English
Choose the correct option that converts the following sentence from Active voice to Passive voice.
"Someone has watered the plants in the greenhouse."

A.  The plants in the greenhouse have been watered by someone.

B.  The plants in the greenhouse has been watered by someone.

C.  Someone has been watered the plants in the greenhouse.

D.  The plants in the greenhouse had been watered by someone.

✓

Q53 English
Identify the antonym of the underlined word in the given sentence.

After the storm, the streets were chaotic.

A.  orderly

B.  disorganized

C.  turbulent

D.  messy

✓

Q54 English
A statement has been given with highlighted text. You are required to replace the text with the correct idiom given in the options.

Vishnu won the big ticket and bought a new house—everyone in town called him a very lucky person.

A.  the life of Riley

B.  a rare bird

C.  a lucky stiff

D.  a lame duck

✓

Q55 English
Given below is a set of labeled segments of a sentence. Out of the given options, select the most logical order to form a coherent sentence.

P: their skills in order to remain relevant
Q: individuals must continuously adapt and upgrade
R: in an era dominated by rapid technological advancements,
S: and competitive in an increasingly dynamic job market

A.  RQPS

B.  SQRP

C.  RPSQ

D.  QSRP
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✓

Q56 English
Complete the sentence by choosing the correct option.

The ruins of the temple provided a ............... glimpse into the country's ancient history.

A.  global

B.  kind

C.  fascinating

D.  loyal

✓

Q57 English
Select the most appropriate article to fill in the blank. If no article is needed, select 'No article required'.

He adopted ___ dog from the shelter last week.

A.  a

B.  an

C.  the

D.  no article required

✓

Q58 English
Select the option that can be used as a one-word substitute for the highlighted group of words.

The professor’s lecture was complex, but the essential or most important part of something—the core meaning—was about the value of
ethical leadership.

A.  Fragment

B.  Ornament

C.  Margin

D.  Pith
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✓

Q59 English
Select the most appropriate option to fill in the blank.

_______ students who met the deadline were appreciated by the principal in the morning assembly.

A.  Few

B.  A few

C.  The few

D.  A little

✓

Q60 English
The question below consists of a set of labeled phrases. Out of the four options given, select the most logical order to form a coherent
sentence.
P: the villagers welcomed the officer
Q: who had resolved their water crisis
R: when he arrived in the morning
S: with garlands and applause

A.  PQRS

B.  RQPS

C.  RSPQ

D.  PRQS

Odia

✓

Q61 Odia
କ୍ରି  ୟା ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

''ଜାପାନ ଦ୍ଵି ତୀୟ ବି ଶ୍ୱଯୁ ଦ୍ଧ ପରେ ଜି ତି ଥି ବା ଦେଶଗୁ ଡି କ ସହ ____ ସନ୍ଧି  କରି ଥି ଲା ।''

A.  ଶାନ୍ତି ରେ

B.  ଖୁ ସି ରେ

C.  ଦୁଃ ଖରେ

D.  ଈର୍ଷା ରେ

✓

Q62 Odia
କ୍ରି  ୟା ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

''କର୍ମ ଚାରୀ ଜଣକ ____ କାର୍ଯ୍ୟ ଟି କୁ  ସମ୍ପନ୍ନ କରି ଥି ଲେ ।''

A.  ଦୟାରେ

B.  ଧୈ ର୍ଯ୍ୟ ରେ

C.  ଶାନ୍ତି ରେ

D.  ଈର୍ଷା ରେ
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✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ବି ପରୀତ ଶବ୍ଦ ଲେଖନ୍ତୁ
ପାହାଡ଼ଟି  ଖୁ ବ "ଉଚ୍ଚ" ଅଟେ।

A.  ନି ମ୍ନ

B.  ଛୋଟ

C.  ନୂ ତନ

D.  ଦୀର୍ଘ

✓

Q64 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ସମାନାର୍ଥ ବୋଧକ ଶବ୍ଦ ଲେଖ।
ଆମେ ଏକ ନୂ ଆ "ଘର" ତି ଆରି  କରି ଛୁ ।

A.  ନି ବାସ

B.  ଜଙ୍ଗଲ

C.  ସ୍କୁଲ

D.  ଦୋକାନ

✓

Q65 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କରୁ  ଦି ଆଯାଇଥି ବା ଇଂରାଜୀ ବାକ୍ୟଟି ର ସଠି କ୍  ଓଡ଼ି ଆ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
Chilika Lake is Asia’s largest brackish water lagoon.

A.  ଚି ଲି କା ହ୍ର ଦ ଏସି ଆର ବୃ ହତ୍ତମ ଲୁ ଣାଜଳ ହ୍ର ଦ ଅଟେ।

B.  ଚି ଲି କା ହ୍ର ଦ ଏସି ଆର ସବୁ ଠାରୁ  ବଡ଼ ଖାରାପାଣି  ହ୍ର ଦ ଅଛି ।

C.  ଚି ଲି କା ହ୍ର ଦ ଏସି ଆର ବଡ଼ ଖାରାପାଣି  ହ୍ର ଦ ଅଛନ୍ତି ।

D.  ଚି ଲି କା ହ୍ର ଦ ଏସି ଆ ସବୁ ଠାରୁ  ବଡ଼ ଖାରାପାଣି  ହେଉଛି ।

✓

Q66 Odia
ସଠି କ ତତ୍ସମ ଶବ୍ଦ ବାଛନ୍ତୁ: “ମନ” ର ତତ୍ସମ କଣ?

A.  ମନଶ୍ଚି

B.  ମନସ୍

C.  ମନସା

D.  ମନସ୍ତି

✓

Q67 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ମୁଁ  ଏବେ ବଜାର ଯାଉଛି  ।

A.  I am going to the market now.

B.  I was going to the market .

C.  I had gone to the market now.

D.  I have been going to the market.
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✓

Q68 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ତୁ ମେ ମତେ କି ଛି  ନକହି  କୁ ଆଡେ ଏକୁ ଟି ଆ ଚାଲି ଯାଇଥି ଲ ?

A.  Where have you gone alone without telling me?

B.  Where did you go alone without telling me?

C.  Why did you go alone without telling me?

D.  How did you go alone without telling me?

✓

Q69 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ|

ଭାରତରେ ଭୋଟର ତାଲି କାର ସ୍ପେଶାଲ ଇଣ୍ଟେନସି ବ ରି ଭି ଜନ (SIR ) ହେଉଛି  ଭାରତୀୟ ନି ର୍ବା ଚନ କମି ଶନ (ECI) ଦ୍ୱାରା ଗ୍ର ହଣ କରାଯାଇଥି ବା ଏକ କେନ୍ଦ୍ରି ତ ଏବଂ ତ୍ୱରାନ୍ୱି  ତ କାର୍ଯ୍ୟ  ଯାହା
ଭୋଟର ତାଲି କା ସଠି କ, ଅନ୍ତର୍ଭୁ କ୍ତ ଏବଂ ଅପଡେଟ ରହି ବାର ନି ଶ୍ଚି ତ କରି ଥାଏ। ପ୍ର ତି ବର୍ଷ  ଭୋଟର ତାଲି କା ସଂଶୋଧନ କରାଯାଉଥି ବା ବେଳେ, ଏକ ସ୍ପେଶାଲ ଇଣ୍ଟେନସି ବ ରି ଭି ଜନ ଏପରି
ପରି ସ୍ଥି ତି ରେ କରାଯାଏ ଯେଉଁ ଠାରେ ଭୋଟରଙ୍କ କ୍ଷେତ୍ର ରେ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ପରି ବର୍ତ୍ତ ନ ଆଶା କରାଯାଏ, ଯେପରି କି  ବଡ଼ ପରି ମାଣର ସ୍ଥାନାନ୍ତର, ପ୍ରା କୃ ତି କ ବି ପର୍ଯ୍ୟ ୟ, ସହରାଞ୍ଚଳ ପ୍ର ସାରଣ, କି ମ୍ବା
ବି ଦ୍ୟମାନ ତାଲି କାରେ ଯଥେଷ୍ଟ ତ୍ରୁ ଟି  ଚି ହ୍ନଟ। ଏହାର ଉଦ୍ଦେଶ୍ୟ ହେଉଛି  ସମସ୍ତ ଯୋଗ୍ୟ ଭୋଟରଙ୍କୁ  ଅନ୍ତର୍ଭୁ କ୍ତ କରି ବା, ଅଯୋଗ୍ୟ କି ମ୍ବା ଡୁ ପ୍ଲି  କେଟ୍  ପ୍ର ବେଶଗୁ ଡ଼ି କୁ  ଦୂ ର କରି ବା ଏବଂ ନାମ, ଠି କଣା,
ବୟସ କି ମ୍ବା ଅନ୍ୟାନ୍ୟ ଜନସଂଖ୍ୟାଗତ ବି ବରଣୀ ସହି ତ ଜଡି ତ ତ୍ରୁ ଟି  ସଂଶୋଧନ କରି ବା। ଏହି  କାର୍ଯ୍ୟ  ସମୟରେ, ବୁ ଥ୍ -ସ୍ତରୀୟ ଅଧି କାରୀ (BLO) ଏବଂ କ୍ଷେତ୍ର  କର୍ମ ଚାରୀମାନେ ଯୋଗ୍ୟ ଭୋଟରଙ୍କୁ
ଯାଞ୍ଚ କରି ବା ପାଇଁ  ପରି ବାର ପରି ଦର୍ଶ ନ କରନ୍ତି , ନୂ ତନ ଭୋଟରଙ୍କ ପାଇଁ  ଫର୍ମ -6 ଆବେଦନ ସଂଗ୍ର ହ କରନ୍ତି  (ବି ଶେଷକରି  ଯେଉଁ ମାନେ 18 ବର୍ଷ  ବୟସରେ ପହଞ୍ଚି ଛନ୍ତି ), ଏବଂ ଯଥାକ୍ର ମେ ଫର୍ମ -7,
ଫର୍ମ -8 ଏବଂ ଫର୍ମ -8A ପ୍ର କ୍ରି  ୟାକରଣ କରନ୍ତି  ଯାହା ଦ୍ଵାରା ବି ଲୋପ, ସଂଶୋଧନ ଏବଂ ସ୍ଥାନାନ୍ତରଣ ହୁ ଏ।
ଏହି  ପ୍ର କ୍ରି  ୟାରେ ଜନ ଅଂଶଗ୍ର ହଣ ଏବଂ ସ୍ୱଚ୍ଛତା ଏକ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଭୂ ମି କା ଗ୍ର ହଣ କରେ। ଭୋଟଗ୍ର ହଣ କେନ୍ଦ୍ର ଗୁ ଡ଼ି କରେ ଡ୍ରା ଫ୍ଟ  ତାଲି କା ପ୍ର କାଶି ତ ଏବଂ ପ୍ର ଦର୍ଶିତ ହୁ ଏ, ଯାହା ନାଗରି କମାନଙ୍କୁ
ସେମାନଙ୍କର ବି ବରଣୀ ଯାଞ୍ଚ କରି ବାକୁ  ଏବଂ ଯଦି  କି ଛି  ତ୍ରୁ ଟି  ଥାଏ ଆପତ୍ତି  ଉଠାଇବାକୁ  ସକ୍ଷମ କରି ଥାଏ, । ଭୋଟର ହେଲ୍ପଲାଇନ୍  ଆପ୍  ଏବଂ NVSP ପୋର୍ଟା ଲ୍  ମାଧ୍ୟମରେ ସ୍ୱତନ୍ତ୍ର ଶି ବି ର, ଭୋଟର
ସଚେତନତା ଅଭି ଯାନ, ସହାୟତା ଡେସ୍କ ଏବଂ ଅନଲାଇନ୍  ସେବା ନାଗରି କମାନଙ୍କୁ  ସୂ ଚନା ପଞ୍ଜି କରଣ ଏବଂ ଯାଞ୍ଚ କରି ବାରେ ସହାୟତା କରେ। ECI ବରି ଷ୍ଠ ନାଗରି କ, ଭି ନ୍ନକ୍ଷମ ବ୍ୟକ୍ତି , ସୀମାନ୍ତ
ସମ୍ପ୍ରଦାୟ ଏବଂ ସେବା ଭୋଟର ଭଳି  ଦୁ ର୍ବ ଳ ଗୋଷ୍ଠୀମାନଙ୍କ ପ୍ର ତି  ମଧ୍ୟ ବି ଶେଷ ଧ୍ୟାନ ଦି ଏ ଯାହା ଦ୍ୱାରା ସେମାନଙ୍କର ଅନ୍ତର୍ଭୁ କ୍ତି  ସୁ ନି ଶ୍ଚି ତ ହୋଇପାରି ବ। ତ୍ରୁ ଟି , ପ୍ର ତି ରୂ ପଣ କି ମ୍ବା ନକଲି  ଭୋଟିଂ
ପ୍ର ବେଶକୁ  ରୋକି ବା ପାଇଁ  କଠୋର ପ୍ର କ୍ରି  ୟା ଅନୁ ସରଣ କରାଯାଏ। ଦାବି  ଏବଂ ଆପତ୍ତି ର ସମାଧାନ ହେବା ପରେ, ଏକ ଚୂ ଡ଼ାନ୍ତ ଅପଡେଟ ଭୋଟର ତାଲି କା ପ୍ର କାଶି ତ ହୁ ଏ। ସ୍ପେଶାଲ ଇଣ୍ଟେନସି ବ
ରି ଭି ଜନ ନି ର୍ବା ଚନ ପ୍ର କ୍ରି  ୟାର ଅଖଣ୍ଡତାକୁ  ସୁ ଦୃ ଢ଼ ​​କରି ବା ଏବଂ ଏକ ସ୍ୱଚ୍ଛ ଏବଂ ସଠି କ ଭୋଟର ତାଲି କା ଆଧାରରେ ନି ର୍ବା ଚନ ପରି ଚାଳନା ନି ଶ୍ଚି ତ କରି ବା ପାଇଁ  ଏକ ସୁ ରକ୍ଷା ଭାବରେ କାର୍ଯ୍ୟ  କରେ।

ସ୍ପେଶାଲ ଇଣ୍ଟେନସି ବ ରି ଭି ଜନ ମୁ ଖ୍ୟ ଉଦ୍ଦେଶ୍ୟ କଣ?

A.  ନି ର୍ବା ଚନକୁ  ଶୀଘ୍ର  ପରି ଚାଳନା କରି ବା

B.  ଭୋଟର ତାଲି କାକୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  ସଂଶୋଧନ ଏବଂ ଅପଡେଟ୍  କରି ବା

C.  ଭୋଟ ଗଣନାକାରୀଙ୍କୁ  ହାତରେ ଗଣନା କରି ବା

D.  ପୋଲିଂ  ଅଧି କାରୀମାନଙ୍କୁ  ତାଲି ମ ଦେବା

✓

Q70 Odia
ଫର୍ମ -6 କଣ ପାଇଁ  ବ୍ୟବହାର କରାଯାଏ?

A.  ନାମ ବି ଲୋପ କରି ବା

B.  ନୂ ତନ ଭୋଟର ଯୋଡି ବା

C.  ପ୍ର ବେଶ ସଂଶୋଧନ

D.  ଅନ୍ୟ ନି ର୍ବା ଚନମଣ୍ଡଳୀକୁ  ଭୋଟ ସ୍ଥାନାନ୍ତର କରି ବା

✓

Q71 Odia
କ୍ଷେତ୍ର  ଯାଞ୍ଚରେ କେଉଁ  ଅଧି କାରୀମାନେ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଭୂ ମି କା ଗ୍ର ହଣ କରନ୍ତି ?

A.  ପୋଲି ସ ଅଧି କାରୀ

B.  ବୁ ଥ୍ -ସ୍ତରୀୟ ଅଧି କାରୀ

C.  ବି ଚାରପତି

D.  ଜନଗଣନା ଅଧି କାରୀ
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✓

Q72 Odia
ସ୍ପେଶାଲ ଇଣ୍ଟେନସି ବ ରି ଭି ଜନ କେତେବେଳେ କରାଯାଏ?
ଯେତେବେଳେ ______.

A.  ପ୍ର ବଳ ବର୍ଷା  ହୁ ଏ

B.  ଭୋଟର ଜନସଂଖ୍ୟାରେ ଯଥେଷ୍ଟ ପରି ବର୍ତ୍ତ ନ ହୁ ଏ

C.  ନି ର୍ବା ଚନ ବାତି ଲ ହୁ ଏ

D.  ବଜେଟ୍  ଘୋଷଣା ହୁ ଏ

✓

Q73 Odia
ନି ମ୍ନ  ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ର ନି ଷ୍ପତ୍ତି  ନେଲା ପରେ ଭୋଟର ତାଲି କା ଚୂ ଡ଼ାନ୍ତ ହୁ ଏ?

A.  ଦାବି  ଏବଂ ଆପତ୍ତି

B.  ନାମାଙ୍କନ ପତ୍ର

C.  ଭୋଟପତ୍ର

D.  ବଜେଟ୍  ପ୍ର ସ୍ତାବ

✓

Q74 Odia
ଯେଉଁ  ବି ଶେଷଣ ପଦ ଅବ୍ୟୟ ପଦକୁ  ବି ଶେଷଣ କରେ,ତାକୁ  କ'ଣ କୁ ହାଯାଏ ?

A.  ଗୁ ଣବାଚକ ବି ଶେଷଣ

B.  ସର୍ବ ନାମର ବି ଶେଷଣ

C.  ସଂଖ୍ୟାବାଚକ ବି ଶେଷଣ

D.  ଅବ୍ୟୟର ବି ଶେଷଣ

✓

Q75 Odia
ନି ମ୍ନୋ କ୍ତ ଶବ୍ଦଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  'ଇଷ୍ଟ' ଶବ୍ଦର ବି ପରୀତାର୍ଥ ବୋଧକ ଶବ୍ଦଟି  ନି ରୂ ପଣ କର।

A.  କଷ୍ଟ

B.  ଇହ

C.  ଅନି ଷ୍ଟ

D.  ଅସୁ ସ୍ଥ
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Computer

✓

Q76 Computer
What does CD stand for?

A.  Compact Disc

B.  Common DIsc

C.  Capture Disc

D.  Current Disc

✓

Q77 Computer
ଯେତେବେଳେ ଜଣେ ବି ଦ୍ୟାର୍ଥୀ  ଏକ ଆଟାଚ ହୋଇଥି ବା ଫାଇଲ ସହି ତ ଇମେଲ ପାଆନ୍ତି ,
ସେତେବେଳେ ତାହାକୁ  ଓପେନ କରି ବା ପୂ ର୍ବ ରୁ  ସେମାନେ କେଉଁ  ସର୍ବା ଧି କ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ସୁ ରକ୍ଷା
ପଦକ୍ଷେପ ଗ୍ର ହଣ କରି ବା ଉଚି ତ?

A.  ସେଣ୍ଡରଙ୍କୁ  ତୁ ରନ୍ତ ରି ପ୍ଳାଏ ଦେଇ ରି ସି ଭ କରି ଛନ୍ତି  ବୋଲି  ସ୍ୱୀକାର କରି ବା

B.  ଫାଇଲ ଏକ୍ସଟେନସନକୁ  ପରି ବର୍ତ୍ତ ନ କରି ବା

C.  ଇମେଲକୁ  ପ୍ର ଥମେ ସେମାନଙ୍କର ସମସ୍ତ କଣ୍ଟାକ୍ଟ ଲି ଷ୍ଟକୁ  ଫରୱାର୍ଡ  କରି ବା

D.  ଏକ ଆଣ୍ଟି ଭାଇରସ୍  ପ୍ରୋ ଗ୍ରା ମ୍  ବ୍ୟବହାର କରି  ଫାଇଲକୁ  ସ୍କାନ କରି ବା କି ମ୍ବା
ସେଣ୍ଡରଙ୍କ ପରି ଚୟ ଯାଞ୍ଚ କରି ବା

✓

Q78 Computer
ଜଣେ ଏଡି ଟର ଏକ ବଡ଼ ଏବଂ ହାଇଲାଇଟେନ ଟେକ୍ସଟରୁ  ସମସ୍ତ ବୋଲ୍ଡ  ଫର୍ମା ଟିଂ , ଫଣ୍ଟ
କଲର ପରି ବର୍ତ୍ତ ନ ଏବଂ ଆକାର ପରି ବର୍ତ୍ତ ନକୁ  ତୁ ରନ୍ତ ହଟାଇ,ଏହାକୁ  କେବଳ ଡି ଫଲ୍ଟ
ଡକ୍ୟୁ ମେଣ୍ଟ ଷ୍ଟାଇଲର ସାଧାରଣ ଫର୍ମା ଟକୁ  ଫେରାଇ ଆଣି ବାକୁ  ଚାହାଁ ନ୍ତି  । ଏହି  ସାଧାରଣ
ଟେକ୍ସଟ ରୂ ପକୁ  ରାପି ଡ ରି ଷ୍ଟୋର କରି ବା ପାଇଁ  କେଉଁ  ନି ର୍ଦ୍ଦିଷ୍ଟ କି -ବୋର୍ଡ  ସର୍ଟ କଟ
ସର୍ବୋ ତ୍ତମ ଏବଂ କାର୍ଯ୍ୟ କ୍ଷମ ଉପାୟଟେ ଅଟେ?

A.  Ctrl + A

B.  Ctrl + B

C.  Ctrl + E

D.  Ctrl + spacebar

✓

Q79 Computer
Which of the following is NOT a valid Internet access technique?

A.  Dial-up connection

B.  Broadband connection

C.  Bluetooth tethering

D.  DVD-ROM access

✓

Q80 Computer
କେଉଁ  ୱି ଣ୍ଡୋଜ ଏଲି ମେଣ୍ଟ, ସି ଷ୍ଟମ ସେଟିଂ  ଏବଂ ଇନଷ୍ଟଲ ହୋଇଥି ବା ଆପଗୁ ଡ଼ି କୁ  ଆକ୍ସେସ
ପ୍ର ଦାନ କରେ?

A.  ଷ୍ଟାର୍ଟ  ମେନୁ

B.  ଟାସ୍କବାର

C.  କୁ ଇକ ଲଞ୍ଚ

D.  ଷ୍ଟାଟସ ବାର

✓

Q81 Computer
MS ୱାର୍ଡ ରେ ଡକ୍ୟୁ ମେଣ୍ଟକୁ  ପୋର୍ଟ୍ରେ ଟ ରୁ  ଲ୍ୟାଣ୍ଡସ୍କେପ ଓରି ଏଣ୍ଟେସନକୁ  ପରି ବର୍ତ୍ତ ନ କରି ବା
ପାଇଁ  ଆପଣ କେଉଁ  ପେଜ ଫର୍ମା ଟିଂ  ଅପସନ ବ୍ୟବହାର କରି ବେ?

A.  Font Size

B.  Page Margins

C.  Page Orientation

D.  Line Spacing

✓

Q82 Computer
What is the main difference between application software and
system software?

A.  Application software controls hardware,
system software is for users

B.  Application software and system
software are same

C.  Application software is for users, system
software controls system

D.  Both are only for gaming

✓

Q83 Computer
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଶି କ୍ଷା କ୍ଷେତ୍ର ରେ କମ୍ପ୍ୟୁ ଟରର ଏକ ସାଧାରଣ ପ୍ର ୟୋଗ ଅଟେ?

A.  କମ୍ପ୍ୟୁ ଟର ହାର୍ଡ ୱେର ଉତ୍ପାଦନ (Manufacturing computer hardware)

B.  କମ୍ପ୍ୟୁ ଟର କମ୍ପୋନେଟଗୁ ଡ଼ି କର ମରାମତି  କରି ବା (Repairing computer
components)

C.  ଇଣ୍ଟରଆକ୍ଟି ଭ ଲର୍ନିଂ ସଫ୍ଟ ୱେୟାର ତି ଆରି  କରି ବା (Creating interactive
learning software)

D.  କମ୍ପ୍ୟୁ ଟର ସର୍କିଟ ଡି ଜାଇନ କରି ବା (Designing computer circuits)

✓

Q84 Computer
What is the shortcut key for a bulleted list in Google Docs?

A.  Ctrl + Shift + r

B.  Ctrl + Shift + j

C.  Ctrl + Shift + 7

D.  Ctrl + Shift + 8
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✓

Q85 Computer
In 'ADDRESS(1,2),' the function '1' refers to the ________ value.

A.  absolute_relative_mode

B.  use_a1_notation

C.  row

D.  column

✓

Q86 Computer
During a professional presentation using a dual-monitor setup,
which Microsoft PowerPoint feature allows the presenter to access
detailed notes, upcoming slides, and a timer, while the audience
views only the current slide on the projector?

A.  Slide Show View

B.  Presenter View

C.  Notes Page View

D.  Outline View

✓

Q87 Computer
What is the primary purpose of Kiosk Mode in MS PowerPoint's Slide
Show Setup?

A.  To allow slides to advance automatically without user
interaction

B.  To prevent the presenter from editing slides

C.  To force the presentation to close after a specific time

D.  To enable animations and transitions automatically

✓

Q88 Computer
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  କାର୍ଯ୍ୟ  ଏଡି ଟ ମୋଡ ଷ୍ଟାର୍ଟ  କରି  ସେଲ କଣ୍ଟେଣ୍ଟର ଶେଷରେ କର୍ସ ରକୁ
ରଖେ?

A.  ସେଲ ଉପରେ ଡବଲ-କ୍ଲି  କ କରି ବା

B.  ସେଲ ଉପରେ କ୍ଲି  କ କରି  ତା'ପରେ ଫର୍ମୁ ଲା ବାର ଉପରେ କ୍ଲି  କ କରି ବା

C.  ସେଲ ସି ଲେକ୍ଟ କରି ବା ପରେ F2 ପ୍ରେ ସ କରି ବା

D.  Enter ପ୍ରେ ସ କରି ବା

✓

Q89 Computer
ତାନ୍ୟା ତାଙ୍କ ବି ଷୟବସ୍ତୁ ସହ ମ୍ୟାଚ କରୁ ଥି ବା ଡେକୋରେଟି ଭ ଇମେଜ ସାହାଯ୍ୟରେ ତାଙ୍କର
ପ୍ରେ ଜେଣ୍ଟେସନକୁ  ଏନହାନ୍ସ  କରି ବାକୁ  ଚାହୁଁ ଛନ୍ତି  । ଏପରି  ଭି ଜୁ ଆଲ ଏଲି ମେଣ୍ଟ କୁ  ନି ଜେ ଡ୍ର  ନ
କରି  ତୁ ରନ୍ତ ଇନସର୍ଟ  କରି ବା ପାଇଁ  ସେ କେଉଁ  ଅପ୍ସନ ସି ଲେକ୍ଟ କରି ବା ଉଚି ତ?

A.  ସ୍ଲା ଇଡ ଇଫେକ୍ଟ ପରି ବର୍ତ୍ତ ନ କରି ବା ପାଇଁ  'Transitions' ଟ୍ୟାବ ବ୍ୟବହାର
କରି ବା ।

B.  ଏକ ଥି ମ ଆପ୍ଲା ଏ କରି ବା ପାଇଁ  'Design' ଟ୍ୟାବ ବ୍ୟବହାର କରି ବା ।

C.  'Insert' ଟ୍ୟାବ ବ୍ୟବହାର କରି  'Online Pictures' କି ମ୍ବା 'Clip Art' ସି ଲେକ୍ଟ
କରି ବା ।

D.  ମି ଡି ଆ ଇନସର୍ଟ  କରି ବା ପାଇଁ  'Animations' ଟ୍ୟାବ ବ୍ୟବହାର କରି ବା ।

✓

Q90 Computer
Which of the following steps correctly allows a user to change the
default column width for all columns in an MS Excel 2021
worksheet?

A.  Go to Page Layout → Width → Set as Default

B.  Select entire worksheet → Home tab → Format → AutoFit
Column Width

C.  Home tab → Format → Default Width → Enter value → click on
OK

D.  Right-click on the worksheet → Column Width → Enter value →
Set as Global
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Reasoning

✓

Q91 Reasoning
A B ର ପୁ ଅ ଅଟେ । B C ର ମାଆ ଅଟେ । C D ର ଭାଇ ଅଟେ । D E ର ଝି ଅ ଅଟେ । A
ସମ୍ପର୍କ ରେ E ଙ୍କର କ'ଣ ହେବେ?

A.  ଝି ଅ

B.  ପୁ ଅ

C.  ଭାଇ

D.  ବାପା

✓

Q92 Reasoning
ସାତଜଣ ଛାତ୍ର  A, B, C, D, E, F ଏବଂ G ଗୋଟି ଏ ଶ୍ରେ ଣୀର ଆଗ ଧାଡ଼ି ରେ ଉତ୍ତର ଦି ଗକୁ
ମୁ ହଁ  କରି  ବସି ଛନ୍ତି  । C ଧାଡ଼ି ର ବାମ ପ୍ରା ନ୍ତରେ ବସି ଛନ୍ତି  । B ଓ D ମଧ୍ୟରେ କେବଳ F ବସି ଛନ୍ତି
। Fଙ୍କର ଡାହାଣକୁ  ଚତୁ ର୍ଥ  ସ୍ଥାନରେ A ବସି ଛନ୍ତି  । A ଓ E ଉଭୟ Gଙ୍କର ନି କଟତମ ପଡ଼ୋଶୀ
ଅଟନ୍ତି  । D ଓ E ନି କଟତମ ପଡ଼ୋଶୀ ନୁ ହଁ ନ୍ତି  । Fଙ୍କର ଡାହାଣକୁ  ଦ୍ୱି ତୀୟ ସ୍ଥାନରେ କି ଏ
ବସି ଛନ୍ତି ?

A.  B

B.  G

C.  D

D.  E

✓

Q93 Reasoning
ସାତଟି  ବାକ୍ସ A, T, K, D, E, F ଓ R କୁ  ଗୋଟି ଏ ଉପରେ ଗୋଟି ଏ କରି  ରଖାଯାଇଛି  କି ନ୍ତୁ
ସମାନ କ୍ର ମରେ ରଖି ବା ଜରୁ ରୀ ନୁ ହେଁ  । T ତଳେ କେବଳ ଦୁ ଇଟି  ବାକ୍ସ ରଖାଯାଇଛି  । E
ତଳେ କେବଳ ଚାରୋଟି  ବାକ୍ସ ରଖାଯାଇଛି  । D ଓ E ମଧ୍ୟରେ କେବଳ ଗୋଟି ଏ ବାକ୍ସ
ରଖାଯାଇଛି  । K ର ଠି କ ତଳେ F କୁ  ରଖାଯାଇଛି  । A ଉପରେ R କୁ  ରଖାଯାଇ ନାହିଁ ।
ଶୀର୍ଷ ରୁ  ଷଷ୍ଠ ସ୍ଥାନରେ କେଉଁ  ବାକ୍ସକୁ  ରଖାଯାଇଛି ?

A.  F

B.  R

C.  D

D.  K

✓

Q94 Reasoning
ଯଦି  ସଂଖ୍ୟା 7846513 ର ପ୍ର ତ୍ୟେକ ଅଯୁ ଗ୍ମ  ଅଙ୍କରେ 1 ଯୋଗ କରାଯାଏ ଏବଂ ପ୍ର ତ୍ୟେକ
ଯୁ ଗ୍ମ  ଅଙ୍କରୁ  2 ବି ୟୋଗ କରାଯାଏ, ତେବେ ଏହି ପରି  ଗଠି ତ ନୂ ତନ ସଂଖ୍ୟାରେ ବାମ ପାର୍ଶ୍ଵ ରୁ
ଦ୍ୱି ତୀୟ ଏବଂ ଡାହାଣ ପାର୍ଶ୍ଵ ରୁ  ତୃ ତୀୟ ଅଙ୍କଗୁ ଡ଼ି କର ସମଷ୍ଟି  କେତେ ହେବ?

A.  12

B.  10

C.  14

D.  8

✓

Q95 Reasoning
WU 10 is related to ZS -3 in a certain way. In the same way, SP 17 is
related to VN 4. To which of the following is WY 29 related, following
the same logic?

A.  KM 9

B.  ZW 16

C.  JH 8

D.  JU 4

✓

Q96 Reasoning
What should come in place of ? in the given series based on the
English alphabetical order?
JFC LGF NHI PIL ?

A.  RJO

B.  MKL

C.  NJH

D.  GTY

✓

Q97 Reasoning
In a certain code language, 'SORRY' is coded as '40' and 'SURE' is
coded as '45'.
What is the code for 'GIFT' in the given code language?

A.  66

B.  61

C.  59

D.  54

✓

Q98 Reasoning
Based on the alphabetical order, three of the following four are alike
in a certain way and thus form a group. Which is the one that does
not belong to that group? (Note: The odd man out is not based on
the number of consonants/vowels or their position in the letter
cluster)11626

A.  UPY

B.  SNV

C.  QLT

D.  OJR
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✓

Q99 Reasoning
Read the given statement(s) and conclusions carefully. Assuming
that the information given in the statements is true, even if it
appears to be at variance with commonly known facts, decide which
of the given conclusions logically follow(s) from the statement(s).

Statements: All tables are goats. No table is a hen.

Conclusion (I): Some hens are goats.
Conclusion (II): All goats are hens.

A.  Neither conclusion (I) nor (II) follows

B.  Both conclusions (I) and (II) follow

C.  Only conclusion (II) follows

D.  Only conclusion (I) follows

✓

Q100 Reasoning
ନି ମ୍ନ ଲି ଖି ତ ଅକ୍ଷର କ୍ର ମକୁ  ଦେଖନ୍ତୁ ଏବଂ ପ୍ର ଶ୍ନ ର ଉତ୍ତର ଦି ଅନ୍ତୁ । ଗଣନା କେବଳ ବାମରୁ
ଡାହାଣକୁ  କରାଯି ବ ।
(ବାମ) L M Q A Z W G B S E J N I O R U A T C F X K P (ଡାହାଣ)
ଏପରି  କେତୋଟି  ସ୍ଵରବର୍ଣ୍ଣ  ଅଛି  ଯାହାର ପ୍ର ତ୍ୟେକର ଠି କ ପୂ ର୍ବ ରୁ  ଏକ ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ  ଅଛି  ଏବଂ
ଠି କ ପରେ ମଧ୍ୟ ଏକ ବ୍ୟଞ୍ଜନବର୍ଣ୍ଣ  ଅଛି  ?

A.  2

B.  3

C.  1

D.  0
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